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Introduction 
 
Introduction to Word 2003 is the first class in the new Word 2003 series.  This new series 
in Microsoft Word 2003 will explore most of the tools available to you by reviewing the 
software by the menu options (File, Edit, View, Insert, Format, Tools, Table, and 
Window).  Each class will cover one or more menu by detailing what the menu options 
are, applicable definitions, practical use suggestions, step-by-step instructions, and 
alternative methods to doing the same task. 
 
The first class in the series, Introduction to Word 2003 will provide a solid foundation for 
which you will build in the remainder of the series.  In this class you will learn: 

◘ How to work with the menus 
◘ How to work with the toolbars 
◘ How to navigate efficiently in Word 
◘ What are Task Panes and how can you use them 
◘ How to specify settings for a variety of Microsoft Word features  
◘ Basic terms that are critical to your full understanding of Microsoft Word 
◘ How to use the various Help features in Word 

 



Word 2003  The University of Akron 

 
Ver. 2005.09.27 Learning Technologies/Software Training Page 3 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

Using Word’s Menus 
 
Definitions 
The Menu Bar is located at the top of the Word Working Screen, just below the Title Bar.  
The menu bar contains the names of Word’s menus and it is used to navigate through the 
commands.   
 
Word’s Menu Bar: 

 
 
 
Why would you use this? 
You use the various menus in Word to accomplish a variety of tasks.  When you click on 
the menu, the specific commands are listed.  You can adjust the settings to show you the 
Full Menu which will list all menu commands or you can show a short list which shows a 
list of the most commonly used commands.   
 
Step by Step 
 
Showing Short or Full Menus 

What you do What happens 

1. From the menu choose: 
Tools, Customize 
 
 
If necessary, click on the Options 
tab. 

The Customize box displays on the Options tab. 
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What you do What happens 

2. If you want the full menu to 
display when you click on the 
menu bar, click in the checkbox for 
the option, Always show full 
menus. 
 

 

3. Note:  If you choose to use short 
menus, this checkbox should be 
cleared.  Short menu’s contains a 
list of commonly used commands. 
There are arrows at the bottom of a 
short menu (chevrons), and you 
can click on these arrows to 
expand the menu to list all options.  
You can also double-click with the 
mouse on the menu command to 
show the full menu.  

 

A short menu: 

 
 

 

Click here to 
expand the 
short menu. 
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Using Word’s Toolbars 
 
Definitions 
A toolbar contains buttons, menus, or combinations of both, which can be used to 
perform actions in Word.  The most common toolbars are the Standard toolbar and the 
Formatting toolbar.  These toolbars are turned on by default.  If you open a toolbar and 
then close Word, the toolbar will still be open when you re-open Word the next time. 
 
Standard Toolbar: 

 
 
Formatting Toolbar: 

 
 
Why would you use this? 
You use the various toolbars in Word, as shortcuts, to accomplish a variety of tasks.  
Most options you have available in the toolbars are also available via a menu option.   
 
Step by Step 
 
Adjusting the Toolbars 

What you do What happens 

1. By default, the Standard and 
Formatting toolbars appear on one 
row.   
 
When more than one toolbar shares 
a row, they overlap and therefore 
some of the toolbar buttons are 
hidden.   
 
To adjust the Standard and 
Formatting toolbars to have 
separate rows select from the 
menu: 
Tools, Customize 
 
 
If necessary, click on the Options 
tab. 

The Customize box displays on the Options tab. 
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What you do What happens 

2. To split the toolbars to separate 
rows, click in the checkbox for the 
option, Show Standard and 
Formatting toolbars on two 
rows. 
 

 

3. You can also adjust the placement 
of a toolbar by using the Move 
Handles.  The Move Handles are 
the four vertical dots at the 
beginning of a toolbar.   
 
To move the toolbar, click with the 
left mouse button on the Move 
Handles, and drag to the desired 
location.   
  

The Move Handles: 
 

 

4. Note:  There are two ways a 
toolbar can be displayed in the 
Word window- docked or floating.
 

 Docked:  A docked toolbar 
means that the toolbar is attached 
to the top, bottom, or sides of the 
Word window.   
 

 Floating:  A floating toolbar 
means that the toolbar is 
somewhere other than the edges 
of the Word window.  You can 
make any toolbar a floating 
toolbar by dragging it with its 
move handles.  Some toolbars, 
such as the Picture toolbar, 
default as a floating toolbar.  
You can move a floating toolbar 
by putting the cursor over the 
title and drag and drop. 
 

 

 
Floating 
Toolbar 

Docked 
Toolbars 
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What you do What happens 

5. You can also adjust what buttons 
are visible on a toolbar.  To add or 
remove buttons from a toolbar, 
click on the Toolbar Options 

button  at the end of the 
respective toolbar and then select 
the option for Add or Remove 
Buttons, and finally select the 
name of the toolbar. 
 
 
Note:  The options that are active 
on the toolbar have a checkmark in 
front such as: 

 
 
 
Note:  Some options that are 
checked may not appear and this is 
because the toolbar is sharing a 
row with another toolbar and there 
is not enough room. 

All toolbar options for the toolbar are listed.   

 
6. To remove an option from the 

toolbar, click on it to remove the 
checkmark.   
 
To add an option to the toolbar, 
click on it to add a checkmark. 
 
Note:  To return the toolbar to the 
original settings, click on the Reset 
Toolbar option at the bottom.  This 
will return the toolbar to the 
defaults. 
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What you do What happens 

7. To open additional toolbars or to 
close an existing toolbar select 
from the menu: 
View, Toolbars 
 
Note:  You can also access the 
toolbar list by placing the cursor 
anywhere in the toolbar area at the 
top of the working screen.  You do 
this by right-clicking with the 
mouse and the same list will 
appear as when you use the menu 
option. 
 

A list of all toolbars displays. 

 
8. To remove a toolbar, click on the 

name to remove the checkmark.   
 
To add a toolbar to the working 
screen, click on the name to add a 
checkmark. 
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Task Pane 
 
Definitions 
A task pane is a side pane that appears on the right side of Word’s editing window that 
allows you to choose from all options available to perform a task.  When you first open 
Word, the Getting Started task pane displays.  From this task pane, you have many other 
task panes available by clicking on the downward pointing arrow in the Header.   
 

      
 
 
Why would you use this? 
You would use a task pane for a specific task.  For example, if you just opened Word and 
the Getting Started task pane displays you can use this pane to open an existing file to 
work on or you can create a new document.  You would also use a task pane for a 
specific task, such as Mail Merge.   
 

Other task panes 
available by using 
downward arrow 

Getting Started 
task pane 
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Step by Step 
 

What you do What happens 
1. If you do not want the task pane in 

view, you can remove it.  To 
remove the task pane (when you 
are not working with a task that 
requires it) select from the menu: 
View, and then uncheck the option 
for Task Pane.   
 
Note:  This will only remove the 
task pane for this document and 
not documents that you create after 
this point.  

 

 

2. You can also remove the task pane 
by clicking on the close button in 
the top right corner of any task 
pane.   
 

 

3. If you do not want the task pane to 
display upon entering Word, you 
can turn this option off.   
 
Choose from the menu: 
Tools, Options 
 
 
If necessary, click on the View tab. 

The Options box displays on the View tab. 

 
 

4. Uncheck the first option under 
Show, Startup Task Pane.  
 
Click on the OK button. 
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Tools, Options 
 
There are many options that you can turn on and off to better help you work in the Word 
environment.  Many options can be found by selecting Tools, Options from the menu 
bar.   
 
The Options box: 

 
 
Why would you use this? 
You would use the Options box to make many different kinds of changes to Word.  You 
can make adjustments such as turning on/off the Start Up Task Pane, turning on/off 
Smart Tags, turning the Drawing Canvas off, changing how a hyperlink is opened, 
password protecting a file, and turning on/off spelling and grammar check.  There are 
many more options available by using the eleven tabs in the Options box.  
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Step by Step 
 

What you do What happens 

1. Select from the menu: 
Tools, Options. 

The Options box displays. 

 
2. Make changes to the various tabs 

and then click on the OK button. 
 

 

3. Note:  The following will list the 
changes noted on the previous 
page with the tab name to make the 
change. 
 Turning on/off the Start Up 

Task Pane (View) 
 Turning on/off Smart Tags 

(View) 
 Turning the Drawing Canvas 

off (General) 
 Changing how a hyperlink is 

opened (Edit) 
 Password protecting a file 

(Security) 
 Turning on/off spelling and 

grammar check (Spelling & 
Grammar) 
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Essential Word Terms  
 

Term Definition  

AutoCorrect Options 

 button 
 

(Per Microsoft Help) The AutoCorrect Options button first appears as a 
small blue box when you rest the mouse pointer near text that was 
automatically corrected, and changes to a button icon when you point to it. 
 
If you find on occasion that you do not want text to be corrected, you can 
undo a correction or turn AutoCorrect options on or off by clicking the 
button and making a selection. 
 

Drag When you read the instruction “drag” this means that you hold down the 
left mouse button and “drag” the cursor over the text, graphics, or pictures, 
that you want selected or to drag the already selected items to another 
location.  
 

Drawing Canvas (Per Microsoft Help)  An area upon which you can draw multiple shapes.  
Because the shapes are contained within the drawing canvas, they can be 
moved and resized as a unit. 
 

Font A font is a set of all the characters available in one typeface and size, 
including uppercase and lowercase letters, punctuation, and numerals.  The 
default font is Times New Roman.   
 

Hard Return (Enter) A hard return is when you press the Enter key to move to the next line.  
When you press the Enter key you are forcing Word to start a new 
paragraph.   
 
A hard return’s hidden code appears as ¶ and can be seen in the typed 
example below. 

 
Insertion Point The insertion point is the small flashing vertical bar that indicates where 

you can begin entering or editing data.  
 

Paragraph A paragraph is a group of text that belongs together and is ended when you 
use the Enter key to move to the next line to start over. 
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Term Definition  

Paste Options  
button 

(Per Microsoft Help)  The Paste Options button appears just below your 
pasted selection after you paste text.  When you click the button, a list 
appears that lets you determine how the information is pasted into your 
document.   
 
The available options depend on the type of content you are pasting, the 
program you are pasting from, and the format of the text where you are 
pasting. 
 

Section Break Sections can be used to vary the layout of a document within a page or 
between pages.  A section break is used to show the end of one section.  A 
section break stores the section formatting such as columns, 
headers/footers, page layout (portrait and landscape), and margins.   
 
When sections are created you can format each section the way you want, 
regardless of how different the two sections are.   
 

When you have your hidden codes turned on, section breaks appear as 
follows: 

 
 
 

Show/Hide Tool The Show/Hide button is found on the Standard Toolbar.  It appears as 
follows: 

 
This is a toggle button.  To show hidden formatting marks, click on the 
Show/Hide button.  The button will become highlighted.  To turn this 
option off, click on the button again.   
 
When you turn this option on, you will be able to see markings for spaces, 
hard returns, soft returns, tabs, section breaks, manual page breaks, and 
more.   
 

Smart Tags (Per Microsoft Help) Smart tags can save you time in performing actions 
in Word that you would normally open other programs to do.  For 
example, a person name or the name of a recent Outlook e-mail message 
recipient is a type of data that can be recognized and labeled with a smart 
tag.   
 
The purple dotted lines beneath text in your document indicate the smart 
tags.  
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Term Definition  

Soft Return (Manual 
Line Break) 

A manual line break ends the current line and continues the text on the 
next line and does not create a new paragraph like a Hard Return.  Using 
this will carry any formatting to the new line.  You create a Soft Return by 
clicking Shift + Enter.   
 
 
A soft return’s hidden code appears as follows: 

 
 
 

Status Bar The Status Bar provides information about the open document, and the 
current settings and operations in progress. 
 

 
 

Styles A style is a collection of character and paragraph formatting that can be 
saved.  Instead of applying each format individually, you can apply all of 
them at one time by using a style.  The default style in Word is the Normal 
style which is Times New Roman, point size 12, left aligned, and single 
spaced.  There are many other styles available for use or you can create 
your own custom styles.   
 

Tab Tab stops are locations across the page that help you to align text. When 
you use the Tab key, the tab stops are set every half-inch.  You can also 

create manual tab spacing by using the Tab Selector     
button to the left of the horizontal ruler or by using the menu option 
Format, Tabs. 
 
A tab’s hidden code appear as follows in the body of the document: 

 
 
Custom tab marks appear on the horizontal ruler as follows: 

 
 
 

Taskbar The taskbar is used to open and switch between applications.  It contains 
the Start button, the quick start buttons, task buttons, and the system tray.  
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Term Definition  

View Buttons The View buttons allow you to quickly switch between the most common 
Word views.  The buttons are located in the bottom left corner of the Word 
window.   
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Navigating and Selecting in Word 
 

Name Description 

Alt  
(To open menus) 

You can use the Alt key to open menus without the assistance of the 
mouse.  Hold down the Alt key and then the letter that is underlined in the 
menu you want to open.  For example, if you want to open the Format 
menu hold down the Alt key and press O.  This will open the Format menu 
as follows: 

 
Continue to hold down the Alt key and press the letter that corresponds to 
the next menu choice.   
 

Arrow Keys Use the arrow keys on the keyboard to move the insert point up and down 
line by line and right and left character by character. 
 

Click and Drag To cut a word out of a paragraph and paste it to a new location first select 
the text.  After the text is selected, point to it with the mouse and hold the 
mouse button down.  Then, drag the text to a new location and release the 
mouse button. 
 

Click and Hold Click and hold is the action of clicking the left mouse button and holding it 
down.  

Ctrl + Click and Drag To copy a word out of a paragraph and paste it to a new location first 
select the text.  After the text is selected, point to it with the mouse and as 
you drag the text hold down the Ctrl key.  Then, release the mouse button 
when you want to drop the copied text.   
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Name Description 

Ctrl + Home Moves to the top of the document quickly. 
 

Ctrl + End Moves to the end of the document quickly. 
 

Drag Select  To select text you can place the mouse cursor over the first part of what 
you want selected and then with the mouse, drag the cursor over the 
remainder of what needs to be selected. 
 

End Repositions the insertion point at the end of a line of text. 
 

Home  Repositions the insertion point at the beginning of a line of text. 
 

Overtype mode  
(Insert Key) 

If you are in Overtype mode then when you type each character will 
replace an existing character.  If you are not sure you are in Overtype 
mode, look in the status bar.  If the letters OVR are highlighted in black, 
then you are in Overtype mode.  To turn this off, click on the Insert key or 
double-click on the letters, OVR in the status bar. 
  

Page Down Moves the insertion point and the visible area of the document forward one 
screen at a time. 
 

Page Up Moves the insertion point and the visible area of the document backwards 
one screen at a time.  
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Name Description 

Scroll Boxes Scroll boxes are used to navigate windows in very large increments by 
clicking and dragging them along the scroll bar.   

 
 

Scrolling Scrolling is the process of navigating through the document.  You can use 
the Scroll Arrows found on both the horizontal and vertical scroll bars to 
navigate is small increments. 

    
You can use the Previous and Next page icons to go back or forward a 
page. 

  
Select a Paragraph 
Triple Click 

To select an entire paragraph, triple click with the mouse. 

Select a Sentence To select one sentence hold the Ctrl key and click anywhere in the 
sentence.  

Select a Word  
(Double Click) 

To select a word, double click with the mouse to quickly select it. 

Select All You can select the entire document quickly by holding the Ctrl key and 
pressing A.  You can also use the menu option of Edit, Select All. 
 

Selection Bar 
(Selection Area) 

The white space in the left margin can be used to select lines in a Word 
document by dragging up or down in the selection bar area.  You can also 
double click in the selection bar to select a paragraph.   
 

Shift + Click To select a group of text first put the insertion point before the first 
character.  Then, hold down the Shift key and go to the end of the area you 
want to select and click with the mouse after the last character you want 
selected.   
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Using Help 
 
Option 1:  Using Help Box 
 

What you do What happens 

1. At the top of the Word window, 
you will see the Help box.  It 
appears as follows: 

 
 

 

2. You can enter a word or phrase for 
the question that you have.  
 

 

3. For example, if information on 
templates is needed: 

 
 
After you enter the word or phrase, 
press the Enter key. 
 

The Search Results task pane displays. 

 
 

4. Notice that there are different types 
of help files.  Some are actual 
templates, there are tutorials, there 
are step by step instructions, etc. 
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Option 2:  Using Word Help Task Pane 
 

What you do What happens 

1. From any task pane, use the down 
arrow at the task pane title bar and 
select Help from the drop down 
list. 
 

The Help task pane displays. 

 
 

2. In the Search for field, enter the 
word or phrase that you would like 
to research. 
 
Click on the Start searching  
button. 
 

The Search Results task pane displays. 
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Option 3:  Using Microsoft Web Sites 

What you do What happens 

1. There are a lot of very useful web 
sites that can provide great 
information for helping you use 
Word.  
 
This lesson will provide some of 
the locations that you may find 
useful. 
 

 

2. In Internet Explorer, enter the following url in the Address Bar: 
http://support.microsoft.com/newsgroups/ 
 
This will take you to the following page: 

 
 
In the left frame locate the following: 
English, Office, Word and then locate the topic area you desire 
 

http://support.microsoft.com/newsgroups/
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What you do What happens 

3. In Internet Explorer, enter the following url in the Address Bar: 
http://office.microsoft.com/en-us/training/default.aspx 
 
This will take you to the following page: 

 
 
Select Word from the list below the Browse Training Courses heading. 
 
A list of available tutorials will display. 
 

4. In Internet Explorer, enter the following url in the Address Bar: 
http://word.mvps.org/index.html 
 
This will take you to the following page: 

 
 

http://office.microsoft.com/en-us/training/default.aspx
http://word.mvps.org/index.html
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Option 4:  Using the Question button 
What you do What happens 

1. When you select certain options 
from the menus, boxes will 
display.  These boxes require you 
to make selections about the 
command that you want to use.   
 
Some of these boxes have a 
Question mark icon in the top right 
corner.   

The Options box. 
 

 
 

2. If you click on the icon, a 
Microsoft Word Help pane will 
display. 
 

The Help pane: 

 
 

3. You can click on the links to get 
additional information about the 
choices available with the 
command you selected.  
 

 

 


